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Introduction
This manual describes how to connect the Display and the External Device (target PLC).

In this manual, the connection procedure will be described by following the below sections:

1 System Configuration
This section shows the types of External 
Devices which can be connected and SIO 
type.

"1 System Configuration" (page 3)

2 Selection of External Device
Select a model (series) of the External 
Device to be connected and connection 
method.

"2 Selection of External Device" (page 6)

3 Example of Communication Settings
This section shows setting examples for 
communicating between the Display and 
the External Device.

"3 Example of Communication Setting" (page 
7)

4 Setup Items
This section describes communication 
setup items on the Display.
Set communication settings of the Display 
with GP-Pro EX or in offline mode.

"4 Setup Items" (page 10)

5 Cable Diagram
This section shows cables and adapters 
for connecting the Display and the 
External Device.

"5 Cable Diagram" (page 15)

Operation
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1 System Configuration

The system configuration in the case when the External Device of Delta-TAU data system, inc. and the Display are 

connected is shown.

Connection Configuration
• 1:1 connection

Series CPU Link I/F SIO Type Setting Example Cable Diagram

PMAC
PC/104
PMAC-Lite 
PMAC-PC

Serial Port on 
CPU RS-232C "Setting Example 1" 

(page 7)
"Cable Diagram 1" 
(page 15)

Turbo 
PMAC

Turbo PMAC1
Turbo PMAC2
Turbo Clipper
QMAC
Geo Brick Controller
Geo PMAC Driver
PC/104 Turbo
Turbo PMAC PCI

Serial Port on 
CPU RS-232C "Setting Example 1" 

(page 7)
"Cable Diagram 1" 
(page 15)

UMAC

Serial Port on 
CPU RS-232C "Setting Example 1" 

(page 7)
"Cable Diagram 1" 
(page 15)

Aux Port on 
CPU*1

*1 This port can be used for general communications. It is possible to turn off the command parser for this                  
port by setting variable I43 to 1, so Turbo PMAC does not try to interpret incoming characters as                 
commands, making it possible for the user to parse incoming data as he pleases.

RS-232C "Setting Example 1" 
(page 7)

"Cable Diagram 1" 
(page 15)
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IPC COM Port
When connecting IPC with an External Device, the COM port used depends on the series and SIO type. Please 

refer to the IPC manual for details.

Usable port

DIP Switch setting: RS-232C

Series
Usable Port

RS-232C RS-422/485(4 wire) RS-422/485(2 wire)

PS-2000B COM1*1 , COM2, 
COM3*1, COM4

*1 The RI/5V can be switched. Use the IPC’s switch to change if necessary.

- -

PS-3450A, PS-3451A,
PS3000-BA, PS3001-BD COM1, COM2*1*2 COM2*1*2 COM2*1*2

PS-3650A (T41 model),
PS-3651A (T41 model) COM1*1 - -

PS-3650A (T42 model),
PS-3651A (T42 model) COM1*1*2, COM2 COM1*1*2 COM1*1*2

PS-3700A (Pentium®4-M)
PS-3710A

COM1*1, COM2*1, 
COM3*2 , COM4

*2 Set up the SIO type with the DIP Switch. Please set up as follows according to SIO type to be used.

COM3*2 COM3*2

PS-3711A COM1*1, COM2*2 COM2*2 COM2*2

PS4000*3

*3 When making communication between an External Device and COM port on the Expansion slot,             
only RS-232C is supported. However, ER (DTR/CTS) control cannot be executed because of the             
specification of COM port. 
For connection with External Device, use user-created cables and disable Pin Nos. 1, 4, 6 and 9. 
Please refer to the IPC manual for details of pin layout.

COM1, COM2 - -

PL3000 COM1*1*2, COM2*1, 
COM3, COM4 COM1*1*2 COM1*1*2

DIP Switch Setting Description

1 OFF*1

*1 When using PS-3450A, PS-3451A, PS3000-BA and PS3001-BD, turn ON the set value.

Reserved (always OFF)

2 OFF
SIO type: RS-232C

3 OFF

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220Ω)  insertion to SD (TXD): None

6 OFF Terminal resistance (220Ω)  insertion to RD (RXD): None

7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available

8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available

9 OFF
RS (RTS) Auto control mode: Disabled

10 OFF
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DIP Switch setting: RS-422/485 (4 wire)

DIP Switch setting: RS-422/485 (2 wire)

DIP Switch Setting Description

1 OFF Reserved (always OFF)

2 ON
SIO type: RS-422/485

3 ON

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220Ω)  insertion to SD (TXD): None

6 OFF Terminal resistance (220Ω)  insertion to RD (RXD): None

7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available

8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available

9 OFF
RS (RTS) Auto control mode: Disabled

10 OFF

DIP Switch Setting Description

1 OFF Reserved (always OFF)

2 ON
SIO type: RS-422/485

3 ON

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220Ω)  insertion to SD (TXD): None

6 OFF Terminal resistance (220Ω)  insertion to RD (RXD): None

7 ON Short-circuit of SDA (TXA) and RDA (RXA): Available

8 ON Short-circuit of SDB (TXB) and RDB (RXB):  Available

9 ON
RS (RTS) Auto control mode: Enabled

10 ON
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2 Selection of External Device

Select the External Device to be connected to the Display.

Setup Items Setup Description

Number of Devices/
PLCs Use an integer from 1 to 4 to enter the number of Devices/PLCs to connect to the display.

Manufacturer Select the manufacturer of the External Device to be connected. Select "Delta-TAU data 
system, inc.".

Series

Select the model (series) of the External Device to be connected and connection method. 
Select "PMAC Controller SIO".
Check the External Device that you can connect in "PMAC Controller SIO" in system 
configuration.

"1 System Configuration" (page 3)

Port Select the Display port to be connected to the External Device.

Use System Area

Check this option when you synchronize the system data area of Display and the device 
(memory) of External Device. When synchronized, you can use the ladder program of 
External Device to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "Display Unit (System Area) Settings Guide"
Cf. Maintenance/Troubleshooting Manual "Main Unit - System Area Settings"
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3 Example of Communication Setting

The following shows examples of communication settings of the Display and the External Device, which is 

recommended by Pro-face.

3.1 Setting Example 1

Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

• If Minimum Frame is checked, Device Address Parts on communication Frame becomes a 
minimum length.
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Settings of External Device
Use the Delta-TAU System PMAC Executive Pro Suite (Pewin32 Pro) to configure communication settings for 

the External Device.

Refer to your External Device manual for details.

1 Start up PMAC Executive Pro Suite (Pewin32 Pro).

2 From the [Setup] menu, select [Force All Windows to Device Number].

3 In the [PMAC Devices] dialog box, click [Insert] to insert a communication port.

4 In the [Available PMAC Devices] dialog box, click [New] to create a PMAC device .

5 In the [Configure Ethernet Devices] dialog box, select [PmacETH0] and define the IP address of the PMAC 

controller.

6 Select the PMAC ETH0 port and click [OK].

7 From the [View] menu, select [Terminal].

8 In the Terminal dialog box, define the Setup Items (I53, I54, I3, I4, I6) 

9 To save your changes in the Terminal dialog box, use the  “SAVE” command. To reset, use the “$$$” command.

Auxiliary Serial Port Baud Rate Control

• I53

Setup Items Type Value

Baud Rate I53=12, I54=12*1

*1 Serial Port is I54, Auxiliary Serial Port is I53. Please refer to           
“Auxiliary Serial Port Baud Rate Control” below.

Data Length -

Stop Bit -

Parity -

Flow Control -

I/O handshake Control I3=2

Communication Integrity Mode I4=2

Error Reporting Mode I6=1

Setting Value Baud rate Setting Value Baud rate

0 Disabled 8 9600

1 600 9 14400

2 1200 10 19200

3 1800 11 28800

4 2400 12 38400

5 3600 13 57600

6 4800 14 76800

7 7200 15 115200
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• I54

Setting Value Baud rate Setting Value Baud rate

0 600 8 9600

1 900 9 14400

2 1200 10 19200

3 1800 11 28800

4 2400 12 38400

5 3600 13 57600

6 4800 14 76800

7 7200 15 115200
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4 Setup Items

Set communication settings of the Display with GP-Pro EX or in offline mode of the Display.

The setting of each parameter must be identical to that of External Device.

"3 Example of Communication Setting" (page 7)

4.1 Setup Items in GP-Pro EX

Communication Settings
To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Setup Items Setup Description

SIO Type Select the SIO type to communicate with the External Device.

Speed Select speed between the External Device and the Display.

Data Length Select data length.

Parity Select how to check parity.

Stop Bit Select stop bit length.

Flow Control Select the communication control method to prevent overflow of transmission and 
reception data.

Timeout Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the 
response from the External Device.

Retry In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.

Wait To Send Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.



PMAC Controller SIO  

GP-Pro EX Device/PLC Connection Manual 11

Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

RI/VCC
You can toggle between RI and VCC on the 9th pin when the SIO type is RS232C.
When you connect to the IPC, to toggle between RI and 5V, use the IPC's changeover 
switch. Please refer to the manual of the IPC for more details.

• Refer to the GP-Pro EX Reference Manual for Indirect Device.
Cf. GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect 

Device)"

Setup Items Setup Description

Minimum Frame

Select the Minimum Frame check box to minimize the length of device addresses in 
communication frames.

For example, M0009 is converted to M9.

Setup Items Setup Description
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4.2 Setup Items in Offline Mode

Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the 

External Device you want to set from the displayed list.

• Please refer to Maintenance/Troubleshooting Guide for more information on how to enter 
offline mode or about operation.
Cf. Maintenance/Troubleshooting Guide "Offline Mode"

• The number of the setup items to be displayed for 1 page in the offline mode depends on the 
Display in use. Please refer to the Reference manual for details.

Setup Items Setup Description

SIO Type

Select the SIO type to communicate with the External Device.

To make the communication settings correctly, confirm the serial interface specifications of 
Display unit for [SIO Type].
We cannot guarantee the operation if a communication type that the serial interface does not 
support is specified.
For details concerning the serial interface specifications, refer to the manual for Display 
unit.

Speed Select speed between the External Device and the Display.

Data Length Select data length.

Parity Select how to check parity.

Stop Bit Select stop bit length.

Flow Control Select the communication control method to prevent overflow of transmission and reception 
data.

Timeout (s) Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the 
response from the External Device.
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Device Setting
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings]. Touch the 

External Device you want to set from the displayed list, and touch [Device].

Retry In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.

Wait To Send (ms) Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.

Setup Items Setup Description

Device/PLC name Select the External Device to set. The device name is set up in GP-Pro EX. (Initial value 
[PLC1])

Min. Frame

Set [Min. Frame] to [Enable] to minimize the length of device addresses in communication 
frames.

For example, M0009 is converted to M9.

Setup Items Setup Description
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Option
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device 

you want to set from the displayed list, and touch [Option].

Setup Items Setup Description

RI/VCC
You can toggle between RI and VCC on the 9th pin.
When you connect to the IPC, to toggle between RI and 5V, use the IPC's changeover 
switch. Please refer to the manual of the IPC for more details.

• GP-4100 series and GP-4*01TM do not have the [Option] setting in the offline mode.
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5 Cable Diagram

The cable diagram shown below may be different from the cable diagram recommended by Delta-TAU data 

system, inc. Please be assured there is no operational problem in applying the cable diagram shown in this 

manual.

• The FG pin of the External Device body must be D-class grounded. Please refer to the manual of the External 

Device for more details.

• SG and FG are connected inside the Display. When connecting SG to the External Device, design the system 

not to form short-circuit loop.

• Connect the isolation unit, when communication is not stabilized under the influence of a noise etc.

Cable Diagram 1

1A)

Display
(Connection Port)

Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
SP5000 (COM1/2)
ST (COM1)
LT3000 (COM1)
IPC*2

PC/AT

*1 All GP4000 models except GP-4100 Series and GP-4203T

*2 Only the COM port which can communicate by RS-232C can be used.
"  IPC COM Port" (page 4)

1A User-created cable Cable length: 15m or less

GP-4105 (COM1) 1B User-created cable Cable length: 15m or less

Signal name

ER(DTR) 4 

SD(TXD) 3 

DR(DSR) 6 

7 RS(RTS) 

SG 5 

FG 

RD(RXD) 2 

CS(CTS) 8 

D-Sub 9 pin (socket)
Display

Pin

Shell 

Signal name

DSR7

RXD5

GND9

TXD3 

10 pin header
External Device

Pin
Shield 

Display 

DTR2
CTS4

RTS6
FGShell

CD1 DCD1
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1B)

Signal name

ER(DTR) 
SD(TXD) 

DR(DSR) 
RS(RTS) 

SG 

RD(RXD) 

CS(CTS) 

Display

Signal name

DSR7

RXD5

GND9

TXD3 

10 pin header
External Device

Pin
Shield 

Display 

DTR2
CTS4

RTS6
FGShell

CD DCD1

Terminal Block
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6 Supported Devices

The following section shows the range of supported device addresses. Please note that the actual supported range 

of the devices vary depending on the External Device to be used. Please check the actual range in the manual of 

your External Device. 

 This address can be specified as system data area.         

Device Bit Address Word Address 32bits Notes

I-Device - I0000 - I8191 *1

*1 I, P, Q and M are 48 bit real devices on the External Device. You can also use hexadecimal and decimal values                     
with these devices. However, the Display handles these device addresses as 32-bit devices.

P-Device - P0000 - P8191 *1

Q-Device - Q0000 - Q8191 *1

M-Device - M0000 - M8191 *1

• Please refer to the GP-Pro EX Reference Manual for system data area.
Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7 Device Code and Address Code

Use device code and address code when you select "Device Type & Address" for the address type in data 

displays.

Device Device Name Device Code (HEX) Address Code

I-Device I 0001 Double Word Address

P-Device P 0002 Double Word Address

Q-Device Q 0003 Double Word Address

M-Device M 0000 Double Word Address

Special Device SP 0060 Double Word Address*1 *2

*1 Read disable

*2 Input device for online commands. You can send commands to the PMAC Controller via the SP device                
without a PMAC Executive Pro Suite (Pewin32 Pro) terminal. When a PMAC controller receives             
alphanumeric text over the serial port, the PMAC controller interprets the set of alphanumeric characters              
as a command and executes the command immediately.



PMAC Controller SIO  

GP-Pro EX Device/PLC Connection Manual 19

8 Error Messages

Error messages are displayed on the screen of Display as follows: "No.: Device Name: Error Message (Error 

Occurrence Area)". Each description is shown below.

Display Examples of Error Messages

"RHAA035:PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

Item Description

No. Error No.

Device Name Name of External Device where error occurs. Device name is a title of External Device set 
with GP-Pro EX. (Initial value [PLC1])

Error Message Displays messages related to the error which occurs.

Error Occurrence Area

Displays IP address or device address of External Device where error occurs, or error codes 
received from External Device.

• IP address is displayed such as "IP address (Decimal): MAC address (Hex)".
• Device address is displayed such as "Address: Device address".
• Received error codes are displayed such as "Decimal [Hex]".

• Refer to your External Device manual for details on received error codes.
• Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the 

error messages common to the driver.
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